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1 Introduction

1.1 Welcome to PC-BSD

Welcome to PC-BSD and many thanks for your interest.

Early 2005 Kris Moore, the founder of PC-BSD, presented the

first beta version of PC-BSD to the community. What some

FreeBSD advocates had been waiting for for years had finally

arrived: an easy-to-use FreeBSD-based operating system for the desktop, with very little configuration

necessary. A polished, full-featured, free-of-charge, open-source operating system with a BSD license,

based on FreeBSD, that anybody could use, from the beginner to the advanced user alike, was a dream

slowly being realised.

With the arrival of "easy-to-use" Linux distributions (another Unix-like operating system) and their

immediate success, it became obvious that there was a large niche market. However, Kris thought that

the Linux market could have advanced more in user friendliness. The BSD community had already very

good server operating systems such as FreeBSD or OpenBSD, but none for the desktop market. Taking a

strong liking to FreeBSD due to its design, speed, and robustness, Kris Moore decided to create a



user-friendly and intuitive FreeBSD based operating systems for desktop use.

PC-BSD is a desktop-oriented operating system to the likes of Microsoft Windows XP or Apple Mac OS

X. It is based on one of the most powerful operating systems for servers, FreeBSD, a Unix-like server

operating system which is based upon the BSD and Unix operating systems, arguably the best of breed

systems nowadays. When it comes to stability, scalability and openness Unix has no competition. In fact

Unix has been the undisputed choice of information technology professionals for many years. [Unix

History Chart | BSD History Chart]

PC-BSD started off as an independent project, but since 10 October 2006 PC-BSD is (financially)

backed and supported by the enterprise-class hardware solution provider iXsystems.

1.2 Differences between PC-BSD and FreeBSD

PC-BSD is essentially a customized installation of FreeBSD, and not a forked-derivative.

PC-BSD is and will always be based on FreeBSD's latest STABLE-branch. Since the

underlying FreeBSD system has been kept intact, you have a fully functional FreeBSD

system under the hood that was built with speed and performance in mind.

It is important to remember that PC-BSD is NOT a Linux distibution. Both FreeBSD and

Linux are Unix-like systems, but PC-BSD is based on FreeBSD and NOT on Linux.

The main difference between PC-BSD and FreeBSD is: PC-BSD is geared towards desktop use, while

FreeBSD has been created with server use in mind. Other differences are:

PC-BSD is based on FreeBSD (currently 7.0) and the KDE desktop environment (currently

4.1.1)

PC-BSD is installed by a graphical installer, rather than FreeBSD’s text based installer,

Sysinstall. However, work in underway to create a graphical installer for FreeBSD

PC-BSD installs a number of pre-installed applications, whereas FreeBSD lets you choose

your own applications

PC-BSD supports all the standard packaging systems provided by FreeBSD (PKG, Ports,

source) as well as its own PBI package system (see Package Management)

PC-BSD’s kernel has been recompiled with some configuration tweaks to better suit it for

desktop use

PC-BSD comes pre-configured with a number of automatic scripts (i.e. to connect (mount)

digital cameras or USB memory sticks etc) that only work in KDE. So, if you want Gnome

desktop environment instead of KDE, for the time being, you will have to install FreeBSD

with Gnome or manually install Gnome onto PC-BSD. Be very careful when you install

Gnome onto PC-BSD, since most, if not all, PC-BSD tools, which are KDE based, will not

work.

So, in summary, there is no real difference between PC-BSD and FreeBSD. PC-BSD is basically

FreeBSD with a nice installer, some pre-configuration, kernel tweaks, PBI package management, a

couple pre-selected packages and some handy (GUI) utilities to make PC-BSD suitable for desktop

use.As a user of PC-BSD, you don’t have to worry about configuring your system, but rather to simply

install it and start working and/or playing with it.



1.3 Microsoft Windows and PC-BSD

As you may already know or will have gathered from the preceeding paragraphs, PC-BSD is a different

kind of operating system compared to Microsoft Windows. FreeBSD (the base of PC-BSD) has been

built with stability and security in mind, and these properties don't particulary spring in mind when

thinking of Windows.

Let's have a look at some similarities and differences between PC-BSD and MS Windows.

Some similarities:

Both have a useful graphical user interface (though the command line is available in

PC-BSD)

Both have a excellent internet connectivity stack (IPv4 and IPv6). Did you know Microsoft

borrowed from FreeBSDs TCP/IP code?

Both have a large collection of applications available (currently 19.000+ for FreeBSD)

Both can browse and share Windows networking resources (SMB shares, printers)

Both can handle audio/video, can play CDs/DVDs and can be used for word processing,

photo editing, databases etc

Installing software is easy, quick and straight forward

However, there are also some major differences:

PC-BSD is free of charge and its source code is free to view and to download

PC-BSD doesn't have a registry database where all the operating system's settings are stored,

so your computer won't get slow after a few months' of use

PC-BSD is not affected by viruses, spyware and other malware that plague Windows

systems

PC-BSD doesn't always have drivers or support for the latest or less popular hardware

Hard drives or partitions with PC-BSD installed don't need to be defragmented to increase

the PC's speed

1.4 PC-BSD's goals

The PC-BSD Team aims to

make software installation as painless as possible and as easy as clicking a mouse button. To

install software you simply double-click on a ready-to-use pre-built software package and

the software will be installed without you having to worry about dependencies and other

technical details. PBIs can be downloaded for free from www.pbidir.com.

create a minimalist operating system that is lean and fast. PC-BSD comes with a minimum of

software installed so you can add only those packages you're interested in.

release versions that are backwardly compatible.

1.5 Reasons for using PC-BSD

PC-BSD has been designed with the "casual" computer user in mind. Installing the system is simply a

matter of a few mouse clicks and a few minutes for the installation process to finish. Hardware such as



video, sound, network and other devices are auto-detected and available at the first system startup.

Home users will immediately feel comfortable with PC-BSD's KDE desktop interface.

PC-BSD is a safe, secure and stable operating systems from the BSD family that is virtually immune to

any virus infection. With PC-BSD you can safely surf the internet without worrying about websites

dropping trojans, virusses, adware or spyware on your system without your consent. PC-BSD lets you

run the best open-source applications, a number of Windows programs and (nearly all) Linux software.

This is all free.

PC-BSD's key features include all that a modern operating system has to offer. It combines the

rock-solid stability, security and speed of FreeBSD, the usability and functionality of the KDE desktop

environment and the simplicity of PC-BSD's software package management to provide a system that's

easy to use and to install. Installing andremoving software has been made as easy as clicking your mouse

button and your system is kept up-to-date with automatic downloads. With PC-BSD it is now possible to

combine the strength of FreeBSD with the ease of use of Microsoft Windows in the same system.

With PC-BSD you can do about everything a desktop user expects from a modern operating system.

Nearly all day-do-day computer tasks and fun stuff can be done on PC-BSD:

Browse the web and send/receive emails

Chat with friends on Yahoo, MSN, AOL and IRC

Listen to mp3's, podcasts, streaming music/radio stations

Burn/rip CDs/DVDs and watch DVDs and videos

Use bittorrent and P2P networks for file sharing

Create drawings. Import, view and edit pictures and digital photo's

Play games and play online multi-player games

Write letters, create databases, spreadsheets and slide presentations, etc

1.6 PC-BSD's most bleeding-edge features

Let's discover PC-BSD's unique features...

1.6.1 Visual system installer

Installing PC-BSD is a breeze! To install PC-BSD you only need to put the CD-ROM in the drive,

reboot the system to start the installer, select from menus, type in your information and click buttons to

proceed step by step. PC-BSD does the hard stuff for you, and only asks for the necessary information.

The power user will find it interesting to access the advanced options to custom partition the hard disk

drive or access options such as DiskLabel. When you are done installing, just remove your CD-ROM,

reboot and you are up and running.



1.6.2 Fully graphical desktop environment

PC-BSD comes with the latest stable version of KDE award-winning desktop environment, and a few

essential KDE applications such as, Kate, Kaffeine, or Konqueror. KDE alone will probably cover most

of your day-to-day needs immediately.



1.6.3 Graphical software installer

Installing software can hardly be easier than on PC-BSD. With a fully graphical software installer, you

can install any .pbi file on your computer the same way you are used to on MS Windows or on the Mac.

Double-click the setup file, follow the instructions, click "Next" and you're done! More...

1.6.4 Network Manager

Setting up your local network to access the Internet is easy with PC-BSD.

During installation, PC-BSD configures your connection using DHCP so that if you already have a

connection to the Internet in your home or office, you get connected automatically. You still have the

ability to manually change your network settings such as IP address, gateway, netmask and DNS using

the Network Manager.



1.6.5 System updates

Are you worried about having an outdated operating system? Don't fear! PC-BSD has a built-in system

updater that will notify you of available system updates to install security fixes, bug fixes, system

enhancements and updated PBIs. Read more about keeping PC-BSD up-to-date in chapter 13.

1.6.6 Visually attractive



PC-BSD comes by default with Nvidia videocard drivers and the Compiz-Fusion accelerated 3D

desktop for the next level desktop experience. Also, Adobe Flash is installed so you can watch your

favorite movies and videos on Youtube and Google Video out of the proverbial box.

1.6.7 Optimised for i368s and compatible with the 64-bits architecture

PC-BSD is optimised for the latest systems for optimum speed and performance. PC-BSD is available

for the i386 architecture and for 64bits systems.

1.7 Package Management

As mentioned above, PC-BSD's package management system takes a different approach to installing

software compared to many other Unix-like operating systems. Instead of utilising FreeBSD's ports or

packages system (although these are still available), PC-BSD uses files with the .pbi (Push Button

Installer or PC-BSD Installer) filename extension. All that is necessary to install a PBI is to download it

(e.g. from pbidir.com), double-click to launch the installation wizard program, enter the root password,

follow the installation steps and you're ready to use the program. Uninstalling is just as easy. Installing

PC-BSD software packages (PBIs) is similar to that of Microsoft Windows and Mac OS X. Installing

PBIs is as easy as installing a Windows .exe file.

PC-BSD's own package management system resolves the issue of library dependency problems that

often occur on Linux based systems. This is the feature that sets PC-BSD apart from most free open

source systems that are available. It's easy, simple and straightforward.A PBI installs all software

packages and libraries in their own self-contained directories in /Programs, decreasing confusion about

where the binary programs reside and reducing the possibility of breaking a package if system libraries

are upgraded or changed. The PC-BSD package manager also takes care of creating links in the KDE

menu and on the KDE desktop.

1.8 Summary of PC-BSD's features
Fully functional and free operating system for the desktop; PC-BSD uses the popular KDE

desktop environment

Based on FreeBSD 7.0, a stable, reliable and time-tested operating system in the Unix family

Improvement upon FreeBSD with extremely easy installation and greatly improved

application management

All the major package management systems available that are supported by FreeBSD (PKG,

ports etc), but has additionally the PBI package installer

Major Windows applications available for PC-BSD as PBI (OpenOffice, Firefox, Opera,

VLC etc)

Major KDE applications are included in PC-BSD

Self-installing software packages (PBIs), making installing programs a snap

Graphical system installer, making the system installation process effortless

Graphical tools for system administration

Online upgrades and patches for PC-BSD and any installed PBIs are downloaded and

installed automatically

Ability to read/edit/save Microsoft Word, Excel and Powerpoint files

Safe from viruses, adware, spyware and trojans that plague Windows systems



PC-BSD is able to run Windows XP/2000 through emulators (such as Qemu or Win4BSD)

or Windows applications through Wine.

Adobe Flash 7 supported (Flash 9 available as part of the Win Firefox PBI)

Support for a number of native languages

Friendly and helpful support community

Professional email and phone support available from iXsystems

1.9 More features (advanced/technical)
Based on FreeBSD, a Unix-like free operating system descended from AT&T Unix via the

Berkeley Software Distribution (BSD) branch through the 386BSD and 4.4BSD operating

systems

Licensed under BSD license (may contain many GPL, LGPL and other licensed software)

Optional SWAP space encryption (useful addition to notebook owners)

Powerfull PF firewall (Packet Filter from OpenBSD) automatically configured

RAM memory based and SWAP memory backed temporary drive space mounted as /tmp

Brute-force attack protection with denyhosts security application (IP of attacker is blocked

for 20 minutes IP is unblocked in case you are blocked yourself)

Ability to run almost all GNU/Linux applications like Oracle, WordPerfect, Skype, Doom 3,

Quake 4, etc. through to the Linux Compatibility Layer (LCL). Generally, no noticeable

performance penalty when running Linux binaries compared to native FreeBSD ones

1.10 PC-BSD Releases

As from September 2008 we will number our releases after FreeBSD's, i.e. PC-BSD 7.0 is based on

FreeBSD 7.0, PC-BSD 7.1 will have FreeBSD 7.1 as it's underlying system, etc.

PC-BSD 1.5.1 - 23 April 2008

PC-BSD 1.5 - 12 March 2008

PC-BSD 1.4.1.2 - 4 January 2007

PC-BSD 1.4.1.1 - 4 December 2007

PC-BSD 1.4.1 - 16 November 2007

PC-BSD 1.4 - 24 September 2007

PC-BSD 1.3.4 - 17 April 2007

PC-BSD 1.3.3 - 12 February 2007

PC-BSD 1.3.2 - 19 January 2007

PC-BSD 1.3 - 31 December 2006

PC-BSD 1.2 - 12 July 2006

PC-BSD 1.11 - 19 June 2006

PC-BSD 1.1 - 29 May 2006

PC-BSD 1.0 - 29 April 2006

PC-BSD 0.8.3 - 23 October 2005

PC-BSD 0.8.2 - 25 September 2005

PC-BSD 0.8.1 - 20 September 2005

PC-BSD 0.8 - 13 September 2005

PC-BSD 0.7.8 - 18 July 2005

PC-BSD 0.7.5 - 25 June 2005



2 Pre-installation

The previous chapter contained some background information of PC-BSD. This chapter is about your

hardware, obtaining PC-BSD and getting ready for installation.

2.1 Minimum Hardware Requirements

PC-BSD has moderate hardware requirements and commonly uses less resources than its commercial

counterparts. Before installing PC-BSD on your computer, please make sure you meet the minimum

requirements.

Minimum system requirements:

Pentium II or higher

256MB RAM

6GB of free Hard Drive space (Either partition, or entire disk)

Network card

Sound card

Recommended system requirements:

Pentium 4 or higher

512MB of RAM

12GB of free Hard Drive space (Either partition, or entire disk)

Network card

Sound card

3D accelerated video card (NVIDIA or Intel)

PC-BSD can run on any of the following processors (providing the motherboard is recognised):

AMD Opteron, AMD Athlon, AMD Athlon XP, AMD Athlon 64, AMD Athlon 64 X2, AMD Athlon

FX, AMD Duron, AMD Sempron, AMD Turion 64, AMD Turion 64 X2, Intel Pentium Pro, Intel

Pentium II, Intel Pentium III, Intel Celeron, Intel Xeon, Intel Pentium 4, Intel Pentium M, Intel Pentium

D, Intel Pentium Extreme Edition , Intel Core, Intel Core 2 Duo

Though 256Mb RAM is the absolute minumun, you should use at least 512Mb of RAM if possible. To

play modern video games, you should use a fast CPU, and if you want to create a collection of tunes and

movies on your computer, you should use a larger hard disk drive too.

2.2 Hardware compatibility

Most hardware should work with PC-BSD, but in some cases, cheap hardware has been reported not to

work. If you use mainstream or top-end hardware, such as those that feature VIA or NVIDIA chipsets, it

will usually work flawlessly.

To ensure your hardware is supported, check the FreeBSD 7.0 Hardware List.



2.3 Obtaining PC-BSD

PC-BSD installation CDs can be either bought or downloaded. If you have a slow download connection

or if you want to support the PC-BSD project financially, you can buy the CDs and/or support from

iXsystems, the parent company of PC-BSD, or from FreeBSD Mall, another iXsystems susidiary.

Alternatively, PC-BSD can be downloaded for free.

There are 4 different ways of installing PC-BSD, by:

CD

DVD

USB Flash

Boot Only

There are two PC-BSD installation CD’s. The first one is the system installation CD (required) and the

second contains multi-language support and the essential PBI Pack (optional). If you want PC-BSD in a

language other than English (if available), you will need to download CD #2 as well.

The DVD contains the same as CD1 and CD2, i.e. required installation files, translations, useful PBIs

and the source code.

The USB installation file can be written to USB memory sticks or Flash Cards and be installed from

there.

The Boot Only option allows to start up the installation of PC-BSD which will then pull all necessary

files from over the network of internet. This is recommended for companies and administrators

employing large networks.

2.4 Data Integrity Check

Now that the installation file has been downloaded, it's a good idea to check if the file is exactly the

same as the one on the PC-BSD server, i.e. check theintegrity of your .iso file. Whilest downloading

some bits and bytes may get "damaged" or lost, so it's wise to check the integrity of the downloaded file.

Did you know that missing a few bits can make the CD unusable?

One of the best (and free) data integrity check (also called MD5 checksum) programs for Windows is

called Mat-MD5, but there's nothing wrong with WinMd5Sum.



Click to enlarge.

You will find the MD5 checksum on the download page of PC-BSD for each .iso file. For each of them,

the checksum reported by either Mat-MD5, WinMd5Sum or md5 must be the same as the checksum

listed on PC-BSD's download page. If the MD5 numbers don't match, you'd better download the file

again.

On Unix systems (Linux, FreeBSD), you can use the md5 commandline tool to check the data integrity.:

md5 path_to/downloaded_file.iso

2.5 Burning the installation CD-ROM/DVD

You have now downloaded PC-BSD and checked if the download has gone OK. It's now time to burn

the ISO to a CD or DVD. This section will assist you to burn PC-BSD onto a CD-R (Writable) or on a

CD-RW (Rewritable). This tutorial assumes you already have:

A CD-RW or DVD-RAM drive that allows you to burn media and not just read

A writable medium in your DVD-RAM or CD-RW drive

A file with a .iso extension containing PC-BSD

A Windows or Unix computer to burn your ISO file.

At this point, you will have to choose how you want to burn the downloaded .iso file. If you use a

Windows computer, you can choose from Nero, Burnatonce, ImgBurn or CDBurnerXP. If you use a

Unix computer with KDE (such as PC-BSD), you can use K3B. Alternatively, if you use a Unix

machine with Gnome, you can use Gnome Baker to burn your CD-ROM. And we also have instructions

on how to burn the CD on the MAC.

2.5.1 Burning the CD-ROM on Windows



Burnatonce

Burnatonce is a freeware application that you can use freely for your personal needs. It is a simple and

light-weight application. To use Burnatonce, simply launch it, and click "File > Load New Image...":

Your PCBSD .iso file will then be listed in grey in Burnatonce. Click "Write", and Burnatonce will

start burning your CD-ROM:

A few minutes later, Burnatonce will let you know that the CD-ROM was burned successfully.

ImgBurn

ImgBurn is with Burnatonce one of the easiest image burners available as it's just doing what its name

suggests: burning images/ISO files, and nothing else.

Open ImgBurn, select the "please select a file" button to locate the downloaded ISO and click the CD

image at the bottom to burn.

Click to magnify.

Ahead Nero Burning ROM

Ahead Nero Burning ROM is one of the most popular commercial applications on Windows to burn

CD-ROMs and DVD-RAMs. Although it is commercial, you usually have a month free to test it. Let's

see how you can burn your CD-ROM in a few steps. Launch Nero, and click "Recorder > Burn Image",

select your .iso file and burn your CD-ROM. Alternatively, you can click "File > Open":



Click to enlarge.

In the Windows dialog box, select the penultimate option labeled "Image Files" to display .iso files in

your file browser:

Browse to the directory where you stored your .iso file of PC-BSD; you should see your file listed.

Select it and click "OK". On the next screen, click "Burn", and Nero will start burning your disk:



Click to enlarge.

After a few minutes, Nero will alert you that the burning process is complete and will eject the

CD-ROM for you.

CDBurnerXP

CDBurnerXP is another freeware application for Windows. It has a modern interface and looks similar

to its commercial counterparts. Using CDBurnerXP is also very easy: Launch the application. A dialog

window will appear and ask you whether you want to continue burning files on a writable disk that

already has files (multi session), or whether your CD-ROM doesn't have any content yet (No multi

session). You will click the second option "Don't Continue Disc (No Multi Session)":

Afterwards, CDBurnerXP's main interface will show up. In the upper-left corner, click "File > Write

Disc from ISO File...":



Click to enlarge

A dialog window then appears for you to select your .iso file. Under "Select an ISO image to write",

click the "..." button to select your file:

Click to magnify,



The file will be listed in the main window. The only thing you have to do is "Write Disc", and

CDBurnerXP will start burning your .iso file onto your CD-ROM:

 

2.5.2 Burning the CD-ROM on a Unix system

Using K3B on Unix-like installations with KDE X-Windows

Any Unix-based operating (with the KDE Windows manager) such as PC-BSD, FreeBSD or Linux

distributions using KDE, are suitted to K3B, one of the best CD-ROM burning application for Unix.

K3B has a similar interface to other modern burning software found on Windows, such as Nero Burning

ROM or CDBurnerXP, and is equally easy to use.

Launch K3B and click "Tools > Burn CD Image...":



Click to magnify.

A new window will show up where you can choose your .iso file. Under "Image to burn", click the blue

folder icon to select your file:



Once your file is listed, click the "Start" button in the top-right corner, and K3B will burn the .iso file

onto your CD-ROM.

Using Gnome Baker on Unix-like installations with Gnome X-Windows

Gnome Baker is probably the best CD-ROM/DVD burner for the Gnome desktop. It is also easy to use.

To burn your .iso file, first, launch Gnome Baker and click "Actions> Burn CD Image":



A dialog window will be displayed and you will be able to select your .iso file. Select it and click

"OK":

The last window allows you to select your CD-ROM drive, as well as a few other options. Leave these

options as default. Click "Start" and Gnome Baker will begin to burn PC-BSD onto your CD-ROM

drive:



Gnome Baker will alert you when the burning is finished.

2.5.3 Burning a ISO image on a Mac OSX system

Launch 'Disk Utility' located under 'Applications' -> 'Utilities'

Click to magnify.



Click on 'File' then on 'Open Disk Image...' then browse to the location of the ISO image.

Select the ISO image and click 'Open'.

 

Click to magnify.

The ISO will be displayed in the right hand side pane. Select the ISO image and click the 'Burn' icon.



Click to magnify.

The insert the appropriate media, check the 'Verify burned data' if applicable and click 'Burn'.

Click to magnify.

2.6 Writing the ISO to Flash media

To write the USB ISO file to a Flash Card or USB pen drive you can do this with the Unix command 'dd':

dd if=<path_to/img_file.iso> of=/dev/da0 bs=1m

Just substitute da0 with the device name of your USB stick.

2.7 Partitioning the hard drive

PC-BSD doesn’t come with a built-in partition manager. If you’re planning to install PC-BSD on a

partition, partitions have to be created before installing. Before creating or editing any partitions,

make sure you back up your valuable data first.

PC-BSD can be installed on a PC as the sole operating system; this is the easiest way. Most people

probably want to be able to run Windows or Linux (or both) and PC-BSD on the same computer. To

accomplish this the hard drive need to be partioned, i.e. the disk has to be sectioned on parts for each of

the operating systems (what is disk partitioning?)



So, there are two options for installing PC-BSD:

PC-BSD taking the whole hard disk drive

PC-BSD installed on a partition of the hard disk drive with another operating system on

another partition (dual boot, triple boot, multi boot)

Before you do any partitioning, ensure you have backed up all your valuable data, especially if this is

the first time you install PC-BSD and you have saved data on another partition.

Be aware that BSD operating systems, and hence PC-BSD, only recognise primary partitions and

consider any logical partitions as a whole primary partition. Trying to install on a logical partition will

convert your extended partition into a primary partition and erase all logical partitions of your system.

PC-BSD can be installed on any primary partition; it doesn't necessarily have to be on the first one. Be

careful and make sure you have a backup of your data.

There is a quite a number of partition managers available, of which two Live CDs are particularly useful

and user friendly: PartImage and PartedMagic.

Now that you have a CD-ROM with the latest version of PC-BSD, let's go through the installation!

 

3 Installing PC-BSD

PC-BSD can be installed from installation CD-ROMs and used on a 'real' PC, or it can be downloaded

as an VMware Player image and be run as a 'virtual computer' within Microsoft Windows. A Live CD is

not available as yet.

3.1 Installation from CD/DVD or USB

3.1.1 Introduction

The PC-BSD installer has made installing a Unix-like operating system as easy as installing Microsoft

Windows. When installing PC-BSD you don’t need to use the command line or text-based installers,

neither do you have to manually edit configuration files.

The installation of PC-BSD is a fast, easy and straight-forward process with a pretty looking Installer.

An easy-to-use wizard will take you step-by-step through the whole process by asking a few simple

questions and after a few minutes you will have your system up and running. Though the installation

process has been made as short and as easy as possible, there are still some advanced options available

for power users.

3.1.2 Starting the PC-BSD Installation

Now, let's start the installation.

Ensure that your CD/DVD drive is configured in BIOS as a boot device and power on your computer.



As soon as you can, put the installation CD in the CD/DVD drive, or put a USB pendrive in one of the

USB ports. After a couple of second, a series of lines of code will scroll down the screen, meaning that

PC-BSD is being loaded.

If your computer didn't boot PC-BSD but rather loaded as usual, press the F8 or F12 key until you see a

screen to select the drive of your choice to boot. You may have to edit your BIOS or CMOS settings to

change the boot order of all the bootable devices on your system. When you get a screen to select which

drive to select your drive of choice to boot, select the CD-ROM drive, based on its hardware name,

which should load PC-BSD immediately. Soon after, you should get a screen with the following options:

Click to magnify.

There are in total 9 options to choose from:

Boot PC-BSD [default] - Normal bootup, start with all standard options enabled.1.

Boot PC-BSD with ACPI disabled - This disables the ACPI device / power management,

which may be useful for certain newer BIOS's and laptops [advanced]

2.

Boot PC-BSD in Safe Mode - Boot up PC-BSD with a forced PIO mode (disabling the use

of DMA) and disables write caching for all IDE hard drives and CD ROM drives, disables

the probing of EISA slots (as very few systems have them), and in i386 it also disables the

use of ACPI and the APICs.

3.

Boot PC-BSD in single user mode - Boot to a shell prompt right after the kernel is finished

loading.

4.

Boot PC-BSD with verbose logging - This option displays much, much more detail during

the boot process.

5.

Boot PC-BSD to emergency console - Boot to a PC-BSD emergency text console, which

can provide access to the hard drive, and allow fixing critical system failures.

6.

Run installer in VESA mode - Disable trying to auto-detect the video card driver, and

instead default to VESA mode. Useful when option 1 fails to bring up the GUI installer.

7.

Enable installer ZFS support - This enable Sun's Zetabyte File System. This is for

advanced users.

8.

Escape to loader prompt - Drop to the boot loader prompt to issue advanced commands,

such as changing kernels, etc.

9.

Option 1 ("Boot PC-BSD [default]") is recommended for most users; Simply hit "Enter" or "1" to start

the installation.



3.1.3 Select your Language

The next screen is the actual system installer with the first options:

Click to magnify.

As you can see, the installer is divided into four logical areas:

The left pane with the different steps of the installer, showing the current and completed

steps with a different arrow;

The main area in the centre where the installer expects user input;

The quick tips at the bottom, always here to help you, to explain what each field means, and

how to fill in the fields;

The bottom navigation bar where you can go forward or backward.

While at the initial pane, you must select your language, keyboard layout, and time zone. You can

synchronise your clock with the Internet if you want, or re-adjust your time manually for daylight

savings, if needed in the future. If your keyboard is listed with the wrong details, click the "Change

Keyboard" button to change the keyboard model, layout and variant.



PC-BSD supports the BSDStats.org Project which collects different statistics and data (such as version,

country and CPU) about the use of different BSD flavours and the hardware they run on. By default the

"allow submitting anonymous usage statistics" box is checked. By leaving the checkbox ticked, PC-BSD

will anonymously submit some data about your system to BSDstats.org. It's recommended to keep this

setting "on" so the growth and size of the BSD community can be measured. However, if this setting is

turned off at this stage and you change your mind later, you will have to manually install the bsdstats

port (/usr/ports/sysutils/bsdstats).

3.1.4 License Agreement

When done, click the "Next" button to proceed to the license agreement:

Click to magnify.

This step requires you to accept the license agreement. PC-BSD is free and open-source software, based

on the BSD license. You need to accept that there is no warranty whatsoever in case of loss of data.



PC-BSD comes with proprietary software such as Nvidia video card drivers and Intel firmware. In order

to use these you need to read the agreement and accept it in order to proceed with the installation. By

ticking the “I agree” box, you agree to all licenses.

3.1.5 Install choice

On this screen 3 choices have to be made::

Fresh Installation or System Update / Repair

Desktop Edition or Server Edition

Install frm CD/DVD/USB or install from Network

Select the "Fresh installation" option in the following cases:

You don't have PC-BSD installed on your computer yet, or

You already have PC-BSD on your computer installed but you want to reinstall it and erase

all the content of the PC-BSD partition

Select the "System update / Repair" option if PC-BSD is already installed on your PC, and

you want to keep all your files and

you want to reinstall or upgrade to a newer version of PC-BSD

The difference between Desktop and Servers version is that installs all of PC-BSD but adds the Wine

PBI, secures the firewall, blocks SSH and other ports. A server install disables the X Windows Manager

(but leaves it installed if the user wants to enable it for something), opens the firewall to allow incoming

SSH, and installs a copy of "The Warden" for jail management.

To install PC-BSD from CD/DVD or USB, leave the "install from CD/DVD/USB ticked, but network



administrators can install PC-BSD from the installation server ("Install from Network"). When the

"install from Network" option has been chosen the network settings can be entered and the installation

source be selected after a user account has been created (3.1.6)

When you are done, click "Next" to go to the next step:



3.1.6 User Accounts

In this step, an Administrator account (or "root" account) has to be created, as well as at least one user

account. Similar to other modern operating systems, PC-BSD has mainly two levels of administration:

Administrator-level: Full control over the entire system, can manage files, software and users

(add/edit/remove);

User-level: Control limited to user's directory, cannot install applications system-wide,

cannot edit files outside user directory

It’s good to be aware that the administrator has all system privileges and has access to all parts of the

operating system. Using a computer as an administrator can be dangerous because mistakes can have

system-wide consequences, especially when using the command-line.

To install software, for instance PBIs, the root password is required, so when you're installing a PBI and

you're prompted for a password, enter the root (administrator) password.

Using a computer as user is much more secure, and if damage is done, it will be limited to the user's

directory. This is why at least one user account needs to be created, which you will use to log into

PC-BSD. Note, that it is not possible to log into PC-BSD as administrator. When you have filled in the

information for the new user, click the "Add" button, and the user account should appear in the "User

Accounts" field underneath. You can click a user name at any time and modify the details; clicking

"Apply" will save the changes.

You can leave the "Shell" field as it is. This option is used by power users who can choose which shell to

use by default to interact with the heart of the system using the terminal. The shell is to PC-BSD what

MS-DOS was to MS Windows.

If you're security conscious or if you share the PC with others and you don't want others to access

your files, unmark the checkbox for auto-login.



Make sure you remember your user name (which is CaSe sensitive) as you won’t be able to choose from

a list of user names when you log on!

Click "Next" when the administrator account has been created and at least one user account has been

added, to go to the next step:

3.1.7 Drive Selection

Click to enlarge.

This step allows you to select which physical hard disk drive and which partition are going to be used for

the installation. The "Detected Hard Drives" field lists the disks that PC-BSD has found during boot up,

from which one needs to be selected. If you want PC-BSD to use the entire disk, for instance if you

don't have any other operating systems on your PC, and no separate partition is used to store

documents, you can check the "Use entire disk" option underneath to use all disk space of your hard

disk drive. Be very careful when you select "Use entire disk" as it will overwrite all partitions!

In FreeBSD, and hence PC-BSD, each partition has a code in front of them, such as /dev/ad0s1, which

is the path to the device (dev) file. Naming convention is as follows:

ad0 or da0 means "first drive"

---s1 means "the first partition or "slice" in FreeBSD vocabulary

FreeBSD, starts counting disk drives from "0", and starts counting partitions from "1". Here are a few

examples:

/dev/ad0s1 — First drive, first partition

/dev/ad1s1 — Second drive, first partition

/dev/da0s3 — First drive (SCSI), third partition

/dev/da1s1 — Second drive (SCSI), first partition



You also need to select the partition on which you want to install PC-BSD. If you already have more

than one partition, all of them will be listed under the "Partition Selection" box. Select the one you want

to use.

If Microsoft Windows is already installed and if you wish to have PC-BSD on the same computer, check

the "Install the PC-BSD bootloader" option. The next time your computer boots up, a welcome screen

will allow you to select which operating system you want to use. If you wish to use only PC-BSD on

your computer or if you already have a Unix-based operating system installed with a bootloader such as

Grub, GAG or Lilo, uncheck this option to keep your existing bootloader. When Windows is installed

after PC-BSD, the FreeBSD bootloader will be overwritten and PC-BSD will be unbootable, which can

be easily fixed. More information on the boot process, the FreeBSD bootloader and troubleshooting can

be found here.

If you want to make a custom partition layout mark the corresponding checkbox (recommended for

advanced users only).

Click to enlarge.

If you marked the checkbox for a custom partition layout, you may now edit the partition layout to your

needs.

On the partition editing screen  the BSD disk partitions can be customised. PC-BSD (and FreeBSD)

have two levels of partitioning:

Regular partitions, also known as "Slices" by FreeBSD (ie: C:, D:, etc...);

Sub-partitions invisibles by non-BSD systems, and known as "Partitions" by FreeBSD (ie:

/boot, /var, /home, etc....)

You can keep all your mount points under "/", or you can spread them across several partitions or disks,

or even across raid arrays for maximum performance. At the very least, you need a "/" partition with

enough room for your files (4GB+) and a SWAP partition for virtual memory. Typically, SWAP space is



advised to be set twice as big as your amount of RAM. This is not always necessary, for instance if you

have 1GB of RAM, 1 GB of SWAP is probably sufficient for ordinary users. More information and

examples check the "Allocating Disk Space" from the FreeBSD Handbook.

For more security, you can check the "Use Encrypted Swap Space" option, which will not leave any

passwords or credit card numbers visible in your swap space. Swap Space Encryption can also at a later

stage be turned of or off with the Services Manager.

Click "Next" to go to the next step:

3.1.8 System Components

Click to enlarge.

On the system components screen one or more software packages can be selected for installation (with

the blue arrows). In the "Available Components" box the most common packages are listed, plus the

FreeBSD ports directory and the FreeBSD source code. Selecting and installing packages at this point

saves you from downloading and installing them after the installation PC-BSD.

The following packages are available as components:

Firefox (Mozilla's popular web browser) - website

K3B (Powerful CD /DVD burning tool) - website

Educational Games (KDE Educational package) - website

Games (Arcade, Board, and Card games) - website

Office Suite (The KOffice Suite) - website

Software Development Kit (tools for writing software) - website

Desktop Toys (Misc programs for your desktop)

OpenOffice.org (Full featured office suite) - website

Opera (Web Browser with BitTorrent client) - website



Ports Tree (FreeBSD ports collection) - website

Source Code (FreeBSD system source) - website

To be able to install any of these packages, you will need installation CD #2 (Multi-language support &

Essential PBI Pack).

3.1.9 Ready to install

Click to enlarge.

At this point, you are about to copy all files from the CD-ROM to your hard disk drive.

Click "Next" to start the installation:



Click to enlarge

The system is now being installed. This process is quite fast. On a modern hard disk drive, it should take

around 15 minutes. 

If you're doing the CDROM installation and you selected one or more components, you will be

prompted to insert installation CD #2:

3.1.10 Setup Complete

When you see a note confirming the installation is finished, the setup is complete and PC-BSD is

installed on your computer. You can now safely eject the CD, and click "Finish" to reboot the computer.

If you installed the PC-BSD bootloader, you will have to choose "FreeBSD" from the list, in order to

load PC-BSD. Otherwise, your computer should load PC-BSD directly without your intervention.

3.2 Installation in Sun xVM VirtualBox

Sun xVM VirtualBox is an open source virtualiser created and maintained by Sun. VirtualBox runs on

Windows, Linux, Macintosh and OpenSolaris and supports a large number of guest operating systems.

The advantage of installing a virtual, guest computer is that it runs within it's own designated space on

your PC, the host, so it's great for testing purposes. VirtualBox free and running an operating system

within VirtualBox is reasonably fast.

3.2.1 Setting up a virtual PC

The following is a step-by-step guide on installing PC-BSD on VirtualBox.



Download VirtualBox and install it.

Start VirtualBox, click the "New" button to add a new operating system, read the introduction and click

"Next"

Now enter a name for your operating system (this can be anything you want to call your operating

system), and enter the OS Type, which is FreeBSD:



We need to set max amount of RAM for our virtual PC-BSD to use. Note that this amount of RAM is

taking off your host PC's RAM, so keep it balanced, i.e. if Windows uses 1Gb RAM you can assign

384Mb to PC-BSD:

The next steps allows you to set up a virtual hard drive. Click "next" and then "new" to setup this hard

drive. When the New Virtual Disk Wizard shows up, click "Next". Choose now wether you want a

"Dynamically Expanding Drive" or a "Fixed-size Drive". The first one expands when your guest

operating system, i.e. PC-BSD, grows; the second option reserves the specified amount of disk space for

the guest operating system, whether it's going to be used or not. The last options tends to result in your

guest operating system running faster than running it in a Dynamically Expanding Drive. Note that

you're not going to see another drive in Window, e.g. a E: Drive, but VirtualBox creates a 6Gb file on

your Windows hard disk which it's using as virtual hard drive.



Give the drive a name or leave the name that the Wizard is showing and set the size. The recommended

minimum size is 6Gb, especially if you install the DVD version. Click "Next" and finish the wizard.

Now you should be back on the "Virtual Hard Disk" Screen and your new Hard drive should be listed

under "Boot Hard Disk (Primary Master)".



Click "Next" to go to the Summary Screen and "Finish" to complete setting up the virtual PC-BSD

computer.

3.2.2 Installing PC-BSD

In the previous section we set up a virtual PC; now we're going to boot it up and start the installation

from the CD/DVD drive or straight from the downloaded iso file:

On the main VirtualBox screen, select your PC-BSD from the side and click the "settings" button. You

can make changes to the RAM etc. Make sure you assing enough video memory, otherwide KDE won't

start up (8Mb is not enough, try at least 32Mb if possible)

On the left hand side, select "CD/DVD-ROM" and tick the "mount CD/DVD Drive". When you have

burned a copy of the PC-BSD installation CD/DVD, select your station and put the CD/DVD in the

station.

Alternatively, if you have not burned a CD/DVD you can boot up from the downloaded iso file. Just tick

the radio button before "ISO Image File" and locate the file (you will need to add the iso as a CD/DVD

image on the following screen)



Click to enlarge.

Click OK and you're all set up to boot up the PC (press the green arrow) and the installation. The

installation will just be the same as 3.1 Installation from CD/DVD or USB.

When the installation is finished, untick the "mount CD/DVD Drive" button in the Settings window.

3.3 Installation in VMware Desktop

to be added

 

 

4 First boot and Post Installation

At this point PC-BSD you have installed PC-BSD onto your PC. A few more steps are needed to start

KDE/X Window manage and then we'll show you how to install more fonts, codecs, java, etc.

4.1 Starting up PC-BSD for the 1st time



4.1.1 Boot up selection

PC-BSD shows a boot up menu with eight choices when starting up. Most of them are identical to the

options shown during booting up the PC-BSD Installation CD (see above). However, instead of "Boot

PC-BSD to emergency prompt", option 6 is now "Run installer in VESA mode". This is the option to

choose should you get a black screen or in case you have problems with the screen resolution stopping

you from using KDE.

4.1.2 Display Settings

After the installation, during the first startup, you will need to select your desired screen resolution,

color depth and the video driver. For your monitor's native (or optimum) resolution and the colour

resolution check the screen's documentation or the manufacturer's website. The video card driver can be

selected from the "video driver" dropdown list. To find out what driver you should use, have a look at

the list of common graphics cards and drivers.



Click to enlarge.

Optionally, the settings for the horizontal synchronisation and the vertical refresh can be set and

adjusted on the "Advanced" tab. To add the horizontal and vertical frequency, mark the "Monitor

Settings" tickbox, and enter the details (which, again, can be found in the monitor's documentation or

the manufacturer's website).

Click to enlarge.

When you have entered and selected the different settings, click "Apply" for them to be saved and

tested. If anything goes wrong during testing, you will be taken back to this "Display Settings" screen, so



you can amend the details. If you're happy with the resolution, click "Yes" in the next step. Click "No"

to return to the "Display Settings" screen.

4.1.3 Logon to PC-BSD

After having set up the screen settings and the video card you can log in with the user account details as

set up in 3.1.6. Optionally, you can adjust some session related settings at the bottom on the right.

If you marked the "Auto-login User" in 3.1.6 then you won't see this login screen and PC-BSD will

launch the KDE desktop environment without prompt. Either way, whether you logon manually or

automatically, next you see the KDE splash screen:

PC-BSD is now up and running. Welcome to the desktop.

Click to enlarge.

s you will see, PC-BSD comes pretty much tailored with the common user in mind. Most will have little

to change in PC-BSD's configuration if any. There are still several things that some people like to

change that we have listed here for you.

4.2 Installing applications

Like popular commercial operating systems, PC-BSD makes software installation a breeze. The same

way Microsoft Windows uses a setup.exe or .msi file and Mac OS X uses setup.dmg, PC-BSD uses

an executable setup file with a .pbi extension, standing for PC-BSD Installer.

Search for an application on a .pbi web site such as the PBI Directory



Download the executable .pbi setup file onto your computer

Double-click the .pbi file and click "Next" all the way

It is this simple. Common software that people like to install are OpenOffice.org, the codecs (to play

MP3 and video), or different browsers such as Opera or Firefox.

To find out all the ins-and-outs of installing software on PC-BSD, go over to chapter 7.

4.3 Installing more fonts

It is easy to add more fonts in PC-BSD. There are two ways to install fonts:

Using a fonts .pbi file: Access a web site such as the PBI Directory, search for "fonts",

download your .pbi file, double-click it and install the fonts. Log out from KDE and log

back in. You should be able to use the new fonts

Using regular TrueType font files: Download your .ttf files onto your desktop, then copy

them to your hidden .fonts directory. This can be achieved using the font installer as

follows

Click the lower-left Start Menu (red ball) and click "Settings > System Administration > Font Installer".

The Font Installer will show up:

Click to enlarge

Click "Add Fonts", select your new fonts, and add them. When you are done, click "Ok". You will need

to log out from KDE and to log back in for changes to take effect.

Windows users may feel more comfortable using the Microsoft fonts that can be accessed on the PBI

Directory. After installing these fonts, PC-BSD's fonts will look like MS Windows'.



4.4 Java

The FreeBSD Foundation has a license with Sun Microsystems to distribute FreeBSD binaries for the

Java Runtime Environment (JRE) and Java Development Kit (JDK), which means it is also available for

PC-BSD. Should you need Java for playing games, for online banking or anything else, download the

Java PBI, install it and you're ready to use it.

4.5 Codecs

For license reasons we cannot ship multimedia codecs with PC-BSD. If we did ship codecs, you could

watch movies out of the box, but PC-BSD wouldn't be free of charge. Apple and Microsoft have paid

for codecs and are therefore legally allowed to redistribute them. Another reason why we cannot ship

codecs is that this is illegal in some countries, e.g. the United States. It's not only the governments' laws,

but also the codec's group laws (ex. the MPEG group) that restrict the distribution of codecs. The

Codecs PBI can be downloaded here.

There are a couple of media players available for PC-BSD (either as PBI or installed from ports), such

as KMPlayer, Kaffeine, VLC, and Xine. These media players let you play, together with the Codecs

PBI, about 99% of .wmv, .avi, .qt, .asf, .asx, .ogm, .mp3, .ogg, .m4a, .mpg, DivX, Real Media files

and embedded media. Judging from feedback on the PC-BSD Forums KMPlayer (and to a lesser degree

Kaffeine) seems to be the best player.

However, tastes and experiences are varied and many; some people can play (nearly) all media with

KMPlayer, whereas others have more success with Kaffeine and Xine. Just try and see what works best

for you and if you get stuck please search the for a solution.

4.6 Troubleshooting

So, you want to install PC-BSD? You're excited, but your PC is not taking it? Have problems with

booting up the installation or is the KDE Window manager is not starting? Or did the installation go fine,

but you find that on the first boot things aren't going as expected? In this paragraph we will have a look

at the most common problems occurring when when PC-BSD is intalled..

No PC-BSD Welcome screen



If you can't even get to the above screen, this is probably due to a so called fatal trap 12 error. You

should unplug as many devices as possible, for instance webcams, scanners, printers, USB mice and

keyboards. Keep the bare minimum hardware. If this solves the problem, start plugging in more

hardware one by one to see which device is causing the problem.

ACPI

If the doesn't solve your problem, try disabling ACPI (Advance Configuration and Power Interface)

next time you start up on the very first black & white screen (option 2).

No Graphical Installer

If you can't even start the graphical installer, when you are in the initial text installer screen, select 7

"Run installer in VESA mode".

MD5

As mentioned above (2.4 Data Integrity Check), there's a chance your download may have experienced

a problem and resulted in PC-BSD's installation CD-ROM being corrupted. Even if the file is missing a

few bits, it can make PC-BSD unusable. Check the MD5 checksum of the downloaded file against the

MD5 on the PC-BSD download page.

Hardware compatibility

If you’re still experiencing problems, ensure your hardware is on the FreeBSD 7.0 Hardware List.

LBA

A not uncommon cause for problems is the LBA (Logical Block Addressing) setting in the BIOS. If your

PC is not booting up before or after installation, check your BIOS and turn LBA off (don't leave it on

automatic)

Monitor Detection

It is possible to run the Monitor Detection again if PC-BSD starts up with the wrong resolution or not



using the correct videocard driver. To rerun the monitor detection, start the Display Setup Wizard

(option 7 on the first black and white welcome screen).

If none of the above has fixed your problem, search the PC-BSD forums for a solution or search with

Google BSD or check Chapter 14 - Help & Support.

 

5 PC-BSD Live Mode

5.1 VMware Player
to be added

5.2 Live CD/DVD
to be added

 

6 Exploring PC-BSD

KDE or the K Desktop Environment, is a contemporary and easy to use desktop environment for Unix

desktops and compatible systems, similar to desktop environments found on the Macintosh and

Microsoft Windows operating systems. While KDE includes a window manager, virtual desktops, file

manager, panel, control center and many other components that one would expect to be part of a

contemporary desktop environment, the true strength of this environment lies in the large suite of

applications and interoperability of its components. Desktop environments are the interface that make

interaction of your hands through a mouse/keyboard as logical and easy as possible and display the

results of your actions on the screen in a manner so that you quickly and easily understand the

consequences of your actions. KDE is a desktop environment that aims to be the best graphical interface

between humans and the information they have stored Even though there are a number of desktop

environments available, such as Gnome, XFCE, Enlightenment etc, PC-BSD currently supports KDE

only. KDE Frequently Asked Questions here KDE Quick Start manual here

6.1 KDE Desktop

The first thing of KDE you see is the splash screen with the little glowing icons showing the progress of

loading the desktop.

If you are familiar with MS Windows, you won't get lost with PC-BSD, and if you have already used

KDE, you will feel right at home! PC-BSD's workspace is an intuitive interface that follow common

sense usability rules which you can find in other modern operating systems, with the desktop, a taskbar

at the bottom of the screen and a start button, which in this case is the red icon in the lower-left corner,

also known as the "Start menu", and your application shortcuts in the main screen:



Click to enlarge.

6.1.1 Desktop

The PC-BSD desktop is, just like the system: clean, bare and very customisable. There are only three

icons on the default desktop: two are linking to a website (the PB-BSD homepage and pbidir.com for

PBI packages) and a link to this Guide. The Desktop panel where the 3 shortcuts are, is the place where

documents are placed when saved onto the Desktop. The remainder of the screen spaces is used for

plasmoids, tiny programs that show different kinds of information on your desktop, e.g. last few emails,

progress of a download, a clock, upcoming appointments etc etc The possibilities are endless. Install

widgets click the button on the top right-hand corner.

6.1.2 Taskbar

On the taskbar you will find the start button to start your applications, programs that are running,

current time, audio output regulator, diary appointments, network connection and a updates indicator.

From left to right:

brings up the startmenu

shows, when clicked, all found and mounted disks (incl. USB memory sticks)

lets you switch between 4 virtual screens, i.e. instead of having multiple physical monitors, you

can switch between virtual screens on one monitor.

  



lets you adjust the audio output

keeps track of any appointments that are in Kalendar

activates the network manager when right-clicked. Hovering the mouse pointer over the icon

shows current settings.

links to the Update Manager. Depending on whether PC-BSD and installed PBIs are up-to-date, it

can show different colors, indicating different updates (see Chapter 13 - Keeping PC-BSD

up-to-date.

6.1.3 Start menu

As you will have noticed see, the start menu looks slightly different from the one on Windows. Clicking

the "Start Menu" toggles a list of options:

There are five main buttons at the bottom of the start menu:

Favorites – programs that are marked as favorites are listed here. You can add any program

here by right-clicking on them in the start menu and clicking "add as favorite". Having your

favourite programs listed on this first tab saves you time browsing through the regular

application menu.

Applications – In this list, you can find all applications that come with PC-BSD as well as

software that you installed separately. Applications are sorted by category (Games,

Graphics, etc...).

Computer – shows shortcuts to System Settings, your home folder, the network, root and

the trash can.

Recently Used – shows a list of the last few

Leave – here you can logout, lock and switch users, or shutdown/restart the PC.

6.2 File system

On PC-BSD like most other forms of the BSD Operating System files are stored as part of a single

hierarchy starting with the root folder known as '/'. This is the top level of the file system.

If you have used a DOS or Windows NT based operating before you may have noticed that Unix

derived systems such as PC-BSD use a forward slash ('/') to separate the names of folders in a 'file path'

instead of the backslash ('\'). There is also no such thing as a 'drive letter' under Unix like systems

because all disk partitions and removable media (CDs, DVDs, USB memory ticks, etc) are attached or

'mounted' onto the root (/) of the file system.

Note that the root user account has unlimited access to all files as it is used for system administration

tasks, such as installing new software, starting and stopping certain services, or editing critical

configuration files.

Files are spread out among several directories as is Unix tradition. The programs that are essential for

starting up your system are found in the /boot, /bin, /sbin, /lib, and the /etc folders. You probably will

not use any of these programs unless you choose to explore the command prompt and the directory

structure. These folder are essential to the functioning of PC-BSD’s startup sequence.



More details on disk organisation can be found in the Disk Organisation chapter in the FreeBSD

Handbook.

6.2.1 Folder hierarchy

A full description of the FreeBSD system can be found in the hier manual page. You can view this by

opening a Konsole session and typing the command:

 man hier

Use the up and down arrow keys to move up and down, press the 'q' key when you are done or simply

close the window. You can also view the manual page right in your web browser with Konqueror by

going to the following link

man://intro/usr/share/man/man7/hier.7.gz

Here is a small mapping of the file system (more details can be found in the FreeBSD Handbook)

Directory Description

  

/ Root (top of file system tree)

/PCBSD PC-BSD specific files and programs

/Programs The default storage location of PBI Packages

/bin Critical command line user programs

/boot Stores startup code, including hardware drivers

/compat/linux/ Linux software compatibility files

/dev Device 'special' files

/etc System configuration files

/etc/X11 Your xorg.conf file

/etc/rc.d Scripts for controlling services and system startup

/home Stores individual user files

/home/username Personal files of user 'username'

/lib System libraries for programs in in /bin and /sbin

/libexec Miscellanies system libraries and binaries

/media Mount Point' for storage media, CDs, DVDs, etc

/mnt Temporary 'Mount Point' for disks

/root System Administrators (root) personal files

/sbin Critical command line programs for system admin.

/tmp Temporary file storage

/usr Programs and files used by most PC Users.

/var Files that may vary in size greatly,

/var/log Log files used by the operating system

/var/spool Printer job specific files

/var/db Database files

/usr/bin Command line programs common to all users

/usr/games Command line games for all users

/usr/home A symbolic link for /home

/usr/include Standard 'include' files for C/C++ programs

/usr/lib Libraries for programs in /usr/bin and /usr/sbin



/usr/local Files specific to this system

/usr/local/bin Graphical programs for all users

/usr/local/etc Configuration files for site specific services

/usr/etc/rc.d Scripts for controlling services under /usr/local/*

/usr/local/include Location of 'include' files for C/C++ developers

/usr/local/lib Libraries used by programs under /usr/local/*

/usr/local/man Manual pages for programs under /usr/local/*

/usr/local/sbin Site specific programs for administrators

/usr/local/share Common program data and configuration area

/usr/local/share/applnk Standard K-Menu short cuts

/usr/local/share/doc Documentation for programs under /usr/local/*

/usr/local/share

/examples
Examples from programs under /usr/local/*

/usr/local/share/fonts System wide fonts for graphical applications

/usr/local/share/icons Icon files for KDE (K Desktop Environment)

/usr/local/share/sounds System sounds used by KDE

/usr/local/share/themes KDE Themes shared by all users

/usr/local/share

/wallpapers
Wall papers shared by all users

/usr/local/share

/appname
Data files specific to 'appname'

/usr/ports The local ports tree, used to install software

/usr/share System documentation, manual pages, etc

/usr/share/doc Extra documentation from FreeBSD

/usr/share/examples Examples from FreeBSD documentation

/usr/sbin More command line programs for admins

/usr/src FreeBSD source code

6.2.2 Home Folder

Every user account is given a 'home directory' to store there personal files, a directory is the same thing

as a folder. The home directory is normally named for the users log in name and stored in the /home

folder. For example if your account (login) name on the computer is johnsmith, your personal files

would be stored in the folder /home/johnsmith. It is not a requirement that home directories be created

this way but it is the system default and common convention on many Unix like operating systems.

On PC-BSD a new user receives a set of folders for storing files. Typically these are Documents, Music,

and Images. You are free to do any thing you wish within your home directory. Only the root user

account and your own can modify files; by default all other users can read files. With the exception of

several that are made read-only for security reasons. You can change this, however

6.2.3 Mounting/Unmounting drives

A great example of this is accessing the contents of a CD-ROM. If you place a disk into your CD-ROM

drive PC-BSD will attempt to automatically detect its presence and issue you a prompt asking you what

actions you wish to take. Hardware support is not perfect so results are likely to vary with quality of

your computers ACPI implementation.

If the system fails to detect an inserted disk, right click on the CD-ROM icon on your desktop that



represents your disk and click the mount option, double clicking on the icon should cause it to

automatically mount and browse to its contents. By default the desktop will create a folder to use as a

mount point in the /media folder.

You can also mount partitions from the command line directly using Konsole, which is very useful for

finding problems when partitions fail to mount. Open a konsole and use the following command to

mount your CD-ROM on to the /mnt folder:

mount /dev/acd0 /mnt

The file /dev/acd0 represents the first optical disk drive on your system, this is typically a CD-ROM or

DVD-ROM drive. Each drive is assigned a number starting at zero so to mount your second CD-ROM

drive (if you have one) you would replace /dev/acd0 in the command above with /dev/acd1 and so on.

Once the disk is mounted you can access the files on it from that specific folder, in the above example

our CD-ROMs files can be viewed through the folder /mnt/. You can mount hard drive partitions in the

same way as above but the device names are different (see below).

Before you eject the disk you must close any programs accessing files on the disk and inform the system

that the disk is about to be ejected. This is the same principal as working with a USB stick or an external

hard drive under other operating systems.

Right click on the desktop icon representing your CD-ROM drive and choose to "unmount" it and then

eject the disk. You can also do this from the command prompt in a konsole with the umount command

(note that it is 'u' not 'un'):

umount /mnt

You can mount almost any storage medium like this but in order to modify files on it. You must have file

permissions set on the mount point that allow the necessary user accounts to do so.

On MS-DOS and related operating systems each disk drive is assigned a drive letter, for example A:\

represents the root of your first floppy drive if installed. On PC-BSD since you can mount disks

anywhere on the file system (with sufficient file permissions). It is quite possible to always mount your

disk to /home/username/Floppy instead and so on.

Again, many more details can be found in the FreeBSD Handbook on Mounting and Unmounting File

Systems.

7 Installing Applications

There are several methods of installing software on a PC-BSD system. Each method will be described in

more detail below.

PBI Installer, the easy way (recommended)

Packages, the quick FreeBSD way

Ports, the traditional FreeBSD way

When you install software from a PBI you will be presented with a simple graphical interface which

takes you through the steps to install your software. Similar to many other popular operating systems

you just click and go. Since PBI programs are created from traditional FreeBSD ports and packages,

they are fewer and less up to date than ports.



Ports and Packages are the traditional ways of installing software.

You can get the most up to date software by compiling directly from ports. The quicker method of

installation is by package, but not all software is available as a package.

Installing software via PBI

When you install a program through the PC-BSD Installer system, it is placed with all required files in its

own folder in /Programs and linked into the system. This is very simple and safe to the system as it is not

changed more than necessary to allow the software to function.

To install a PBI we need to go to the PBI Directory and download a program:

Once the download is completed, simply double click on the file to launch the installer. It will prompt

you once for the super user password before beginning the installation process. This is effective as a

security measure, parental control, and prevents accidental alteration of the system.

Click "Next" at the welcome screen, you will then be asked to read any license agreements that comes

with the program you are installing. Check the "I agree" box and click "Next" to continue installation.

You may have the options of placing icons on your desktop and entries in the PBI Programs section of

the application menu. Check all boxes that apply and click "Install":



Once the installation has completed, click " Finished " and try out your program.

You can also install in text mode from a console session by changing directory to the location of the PBI

and run the following as the super user.

# ./PBI_File -text pbifilename-1.0-PV1.pbi

If at a later date you wish to add an icon to your desktop for software installed during a PBI install you

may do so by right clicking on the desktop and selecting "Create new link to application". This will open

a menu where you can set the name of the icon, its picture (click the cog image). Then click the

"Application" tab. Here you will have to set the program you wish to create an icon for, you can set a

comment, description, the work path, and file types as required.

Removing PBI applications

To remove a .pbi application, just go to "Start Menu > Settings > System Administration > Remove

Programs (PBIs)". You will see the list of installed PBI applications:



Click the application you want to remove and press the "Remove" button in the lower-left corner. When

you are done, click "OK".

Installing packages

Packages are prepared files for installing software, they install software into the system and can cause

dependency issues. The package system is comparable to yum, and apt-get used in several Linux

distributions. To find the name of a package, first you need to search on the FreeBSD ports database.

For instance if we want to install Skype, we search for "skype" and we find 2 search results: the

development release and the stable release. If you pass your mouse over the name of the package of the

stable release, you see something like http://cvsweb.freebsd.org/ports/net/skype in the status

bar of your browser. The /net/skype part tells you that the name of the package is skype and that it

belongs to the net category. You don't have to download anything, as the package manager will take

care of that for you. Just remember the name of the package. Installing packages requires you to open a

console with root permissions. You can type kdesu konsole in a run dialog from the K-Menu or open a

konsole from the K-Menu in super user mode, or open a konsole and type su - and press "Enter". You

will be prompted for the root (super user) password, it will not display the password on screen for

security reasons. After switching to the super user account you have complete access to the system and

can install software at will. You can install a program using the package system thusly:

# pkg_add -r irssi

This will install the "irssi" program with all required files but not update the K-Menu or desktop. You

can generally find the binary (executable) in /usr/local/bin, configuration files in /usr/local/share/ or your

home directory and the libraries (like .dll) will be placed into the system as needed and shared

between applications.

You can uninstall a package by using the pkg_delete command and the name and version of the package



or a wild card.

# pkg_delete  irssi-0.8.10_2 # And pkg_delete "irssi-*" are equivalent.

You can get info about an installed package the same way using the pkg_info command.

# pkg_info "irssi-*" # Or pkg_info | grep irssi

Installing software using ports

Traditionally BSD installs software from source; the ports collection. You first need to install an up to

date ports collection before you may use the ports collection to install software. New users coming from

Gentoo GNU/Linux will find this similar to the "Emerge" system which is based on FreeBSD ports.

To install the ports collection click on the K-Menu and navigate to: "Settings > Administration >

PC-BSD System". Enter the super users password to access the admin panel and click on the "Tasks"

tab. Now click "Fetch ports" and it will begin downloading the necessary files and installing them. This

will take a while depending on your Internet connection and Processor speeds.

Click to enlarge.

If you wish to do this from the command line open a console as the super user as described in fetching

packages and run the following command:

# cvsup -g -L 1 /root/ports-supfile

You can also use the portsnap method

# portsnap fetch extract

If you install ports using portsnap you should not update the ports collection with cvsup, instead use:



# portsnap  fetch && portsnap update

if you installed ports using cvsup you may update them in the same way as before:

# cvsup -g  -L 1 /root/ports-supfile

You can edit the supfiles and set a download mirror closer to you, please see the FreeBSD handbook for

more information on using CVSUP.

Now that the ports collection is installed if you look in /usr/ports you will see a simple tree structure

of folders. The structure is in the format of category > program name.

Then, to install an application from ports, just go to the application directory, for instance /usr/ports

/net/skype and start compilation:

# cd /usr/ports/net/skype
# make install clean

After a few minutes or hours, depending on the size of the package, the application is installed on your

system.

Removing a package or a port

To remove a package or port, first you need to find the name of the package. For instance if you want to

remove kopete, to find out its full name, you will type:

# pkg_info | grep kopete
kdenetwork-kopete-0.11_1 KDE multi-protocol instant messenger (IM)

Then to uninstall the package, type as root:

# pkg_delete kdenetwork-kopete-0.11_1

If you installed from the ports, you can also uninstall going to the specific port directory and you can

uninstall from there:

# cd /usr/ports/net-im/kopete
# make deinstall

To learn more about ports and packages, feel free to read the excellent FreeBSD handbook.

11 Networking & Security

PC-BSD comes with an easy network configuration tool allowing you to set up your network and your

network interfaces in no time.

There are two ways to configure your network interfaces:

Either you don't mind using any IP address from your ISP or you don't know what your DNS

servers are, in which case you will use the DHCP protocol (recommended)



Or you have a small network of two or more computers, and you want to assign a local IP

address to each of them such as 192.168.0.1, 192.168.0.2, etc... In which case you will need

to know the DNS servers

To start configuring your network interface, click the Start Menu in the lower-left corner (red ball) and

click "Settings > Internet & Network > Network Settings". The main window will appear. Resize the

window so that you can see the lower buttons:

Click to magnify.

As you can see, for security reasons, all options are greyed out. To edit the settings, you need to click

the "Administrator Mode..." button and type your administrator password at the prompt. Then you will

be able to set up your network interface. To do so, double-click one of the network interfaces listed in

the main window. A popup window appears for you to adjust various settings:



Click to magnify

Select either "Automatic - DHCP" (Recommended) or "Manual", accordingly. If you selected

"Manual", you need to type the following information:

IP address: The IP address you want for the selected network interface. This IP address

cannot be a public IP and needs to belong to private network IP addresses

Netmask: Can be set using numbers (ie: 255.255.255.0) or using hexadecimal values (ie:

0xffffff00)

Activate when the computer starts: This option should be checked if you want to use your

network interface automatically when you start your computer

Description: Type a name to identify your network interface

Gateway: If you connect to the Internet through another computer, server or router, also

known as "gateway", type its IP address

Click "OK", and repeat the procedure for other network interfaces if you have several that are to be

used. If you have a gateway, click the "Routes" tab where you should have your gateway listed and the

network interface through which the route will go:

 

If you selected "Manual" setup, click the "Domain Name System" tab to set up your DNS. This does not

apply if you selected "DHCP" for your network interface.



Click to magnify.

Add at least one DNS here. It is advised that two DNS are set, so that you don't rely on just one. If you

don't know your DNS, either get in touch with the technical support of your ISP, or ask some one who

lives in your geographical region and who is "computer-savvy".

When you are done, click "OK" and your network interfaces are set up. You should be able to access

the Internet and other computers of your network if you have them. If you have a DSL connection that

you need to dial from your computer manually or if you use a dialup connection, please get in touch

with us on the forum for more details to assist you.

12 PC-BSD Tools

KDE comes with great tools for managing certain tasks, but PC-BSD additionally comes with some

extra tools written by the PC-BSD developers for some specific PC-BSD tasks:

The PC-BSD desktop allows users the ability to find nearly anything you would ever want to know

about your system. PC-BSD is built on FreeBSD so users can always use the command line in a terminal

to see system information but what is the fun of that? In PC-BSD/KDE there are specific desktop

programs to do this job for you using a graphical interface.

12.1 System Information

Unique to PC-BSD there is a "System" window that can be opened by clicking on the "Start Menu >

Computer > System Settings > System Manager ". At this point you will have to type in your root

password to allow the System Manager window to open. Once the PC-BSD System window opens you

will be presented with four tabs with the following titles:



General

Kernel

Tasks

Misc

The General Tab

The "General" tab shows us the versions of both PC-BSD and the base FreeBSD system. It's a good idea

to report both of these when asking questions on the PC-BSD forums or any of the FreeBSD lists.

Also found on this tab is a report generator that creates a report by clicking on the "Generate" button.

While this report doesn't show all system attributes, it does hold an abundance of pertinent information.

Items included in the report are as follows:

the kernel responses as your system boots (dmesg)

the last few lines of the /var/log/ messages log file

your resource configuration file (/etc/rc.conf)

your boot configuration file (/boot/loader.conf)

the free space of your hard drive (df -m)

a listing of top (currently running processes)

You will be given an opportunity to save the generated report to a file and directory of your choice.

Once it is saved it will open up in kwrite (or your default KDE editor) for your inspection. While this

report isn't a complete report of every variable of your system, it is a very comprehensive report of most

things that matter and it is quite lengthy. All successful probes and loads as well as most errors will be

reported here.

The Kernel Tab



Here on the "Kernel" tab you are presented with several options. They are:

the ability to select single or multiple processor kernels

enable/disable the splash screen as PC-BSD starts

enable/disable ATAPI DMA Mode

Boot Delay

Please be VERY CAREFUL setting options on this tab. The kernel settings and the ATAPI DMA can

leave your system in an unstable state if set incorrectly.

If you have two physical CPU sockets on your motherboard, an AMD x2, an Intel Hyperthreading CPU

with hyperthreading turned on in the BIOS, or an Intel Core 2 then you should be safe choosing the

Multi Processor kernel option by clicking on its drop down and selecting it.

If you want to see all of the probes and peeks of PC-BSD/FreeBSD as it loads the operating system you

can un-check the "Enable Splash Screen" option and you will see all the raw messages as the system

loads. Some people like to see what is happening and this often comes in handy while diagnosing

problems.

The "ATAPI DMA" option will probably not cause any problems if you turn it off but it may slow down

your disk access. There seems to be some computers with mostly older CD-ROMs or hard drives that

may benefit by having this turned off.

The last option, the "Boot Delay", can be set anywhere from Off to 0 to 60 seconds. It defaults to 1 but

some people prefer to set it higher if they are diagnosing problems or need to boot up with special flags

set.

Any changes on this tab must be saved by clicking on the "Save Changes" button.

 



As on the previous tab, any changes must be saved by clicking on the "Save Changes" button.

The Tasks Tab

Click to enlarge.

This tab could also be called the "Wait" tab because if you run both of the functions on this tab you will

be waiting, and waiting and if you are on dial up connection you could be waiting several hours. The

longest wait is only for the first time they are run, major base updates or long intervals between updates.

Like all good things that teach patience, this wait will reward you richly if you ever need to compile a

kernel or any application not yet available as a PBI. The two functions are:

Fetch System Source

Fetch Ports

The first function, the Fetch System Source, will open a small terminal screen and show you how it

progresses. This will take some time the first run or at long intervals between updating. If you run it on a

regular basis that time will be greatly shortened.

The second function, Fetch Ports, will open a progress window and show you its progress as it

downloads, expands and places the ports tree under the /usr/ports directory. This one will also take a

while to complete if you are using it for the first time or a long period has elapsed between updates.

Once your port tree is downloaded and in place you will be able to open a terminal screen (konsole),

log in as root, change directory to the application you want to install and run a make install clean

to compile and create the application you wish.

The Misc Tab

Here you may select any pictures that you want to see during boot-up.



Click to enlarge.

12.2 Services Manager

The Services Manager is an easy-to-use GUI tool for managing some KDE and FreeBSD services. It

allows services to be enabled/disabled at system startup or change their status to stopped/running.

Click to enlarge.

The following services can be managed with this GUI:

CUPS (Common UNIX Printing System) - CUPS is required if a local (USB or parallel)

printer is being used on your system.



Denyhosts - This is a script that analyses log messages to determine what hosts are

attempting unauthorised access to your system. It also determines what user accounts are

being targeted and it keeps track of the frequency of hacking attempts.

FreeBSD Update - When enabled, the Updater will automatically download and install

updates for FreeBSD, the underlying operating system of PC-BSD. These updates are issued

by the FreeBSD Project and not by the PC-BSD Project.

HAL (Hardware Abstraction Layer) - HAL is an abstraction layer, implemented in

software, between the physical computer hardware and the software that runs on that

computer.

OSS (Open Sound System) - OSS is a cross platform API developed by 4Front

Technologies that provides drivers for most consumer and professional audio devices for

UNIX based operating systems. When your sound card is not producing any sound, activate

OSS and see/hear if that's fixed your problem. There have been occasions where Nvidia

graphics card drivers interfered with OSS producing broken sound. If this is the case, turn

OSS off.

PF (Packet Filter) - PF is OpenBSD's firewall for filtering TCP/IP network traffic and

doing Network Address Translation (NAT). It's recommended to keep the PF firewall turned

on, unless you have installed another firewall or are using a router with a built-in firewall.

[LINK TO PF FIREWALL CHAPTER TO BE INCLUDED LATER]

PF Generator - This PF Generator creates rules for the PF Firewall when booting up

SSH (Secure Shell) - SSH is a network protocol that allows data to be exchanged over a

secure channel between two computers by using data encryption. This is what causes your

internet browser to display the locked pad lock icon at certain (secure) web pages. Secure

Secure FTP (SFTP) and secure copy (SCP) capabilities are handled through the SSH

protocol as well.

cpufreq - cpufreq is a background process (daemon) to adjust CPU speed and voltage on the

fly. This is a nice way to save battery power, because the lower the clock speed, the less

power the CPU consumes. This is especially recommended for laptop users.

 

13 Keeping PC-BSD up-to-date

13.1 Online Update Manager

The Update Manager helps you to keep PC-BSD up-to-date by downloading and installing the latest

patches and updates.

While starting up, PC-BSD checks by default if any updates are available (internet connection is

required). The Updater icon in the system tray (right hand bottom of the screen next to the clock) shows

whether your system is up-to-date or not.

There are five different states of the Updater system tray icon:

Your system is up-to-date

Looking for updates and patches



Your system is out-of-date; system update(s) and patche(s) are available to be downloaded and

installed

PBI update(s) are available for downloading and installing

Selected updates and patches are being installed

There are different ways to launch the Update Manager:

by clicking the PC-BSD Start button -> Settings -> Software & Updates -> Online Update

Manager, or

by double-clicking on the Updater icon in the system tray or by right clicking it and selecting

"start the Update Manager"

The Update Manager contains three tabs. To for checking for and downloading of new downloads and

one for different setting::

System Updates

PBI Updates

Configuration

Let's have a look at each of the different tabs.

System Updates

Click to magnify

This screen is divided into two sides. On the left hand side are any available updates listed. These can all



be selected at once by clicking the “Select All” button or by selecting them manually. On the right hand

side you see the “Check for Updates” button which, when clicked, will connect to the update server to

check if any updates are available.

If any updates are found, a "System updates are available" pop-up window

comes up, and the updates are shown in the “available updates” pane.

Though the installation of updates is highly recommended as they make

your system more secure, add more functionalities and fix bugs, these updates are not mandatory;

you’re free to download and install (a selection of) them. Oh, and you don't have to verify if you have a

valid PC-BSD license ;-)

Selected updates will be downloaded and installed when the “Install selected updates” button is clicked:

To view the progress of the downloading and installation, double-click the Updater icon in the system

tray which will then bring up a screen similar to this one:

When the installation of the update(s) is successfully completed, the Installer will notify you of this with

either "Updates successfully installed" or "Updates successfully installed! Your system will need to

reboot to finish". In the latter case, clicking the OK button won't reboot the PC automatically. Finish

whatever you're doing and reboot the computer at a convenient time manually.

PBI Updates



Click to magnify

The second tab window, PBI Updates, is identical to the System Updates tab, but with one difference:

instead of looking for updates for the PC-BSD operating system, the Updater will check, when you click

on the "Check for Updates" button, if there are any newer PBIs listed on pbidir.com than those that are

already installed on your PC. For instance, if you have installed Firefox 2.0.0.11 and version 2.0.0.12

has been added to the pbidir.com website later, the Updater will list version 2.0.0.12. The older version

can then by removed and the latest installed.

To manually check if there are more recent PBI versions available, click the

"check for updates" button. In case there are newer versions of your PBIs on

pbidir.com, they will be listed on the "available programs" window and a little

message pops up in the system tray advising of new PBI updates being

available.

Configuration



Click to magnify

The Configuration tab has tree options which are all activated by default in order to check for system

and PBI updates at system bootup.

Downloading and installing of system updates are highly recommended in order to keep your system

safe and free of bugs. By default the Updater will also check if any newer and more up-to-date versions

have been added to pbidir.com after you installed a particular PBI.

The last option on the Configuration panel is "Run the System Updater at startup". PC-BSD checks by

default if any updates are available on PC-BSD's update server. If, for any reason, you deem this not

necessary, this option can be turned off.

 

14 Help and Support

Professional PC-BSD support is available from iXsystems, but it's probably quite a safe assumption that

most users will turn to the internet for help first. We are doing our best to make PC-BSD as easy as

possible for newcomers. Should you need help with anything, there are plenty of ways to get in touch

with the Team and with the community.

14.1 Forums

The PC-BSD Forums contain a wealth of information, tips and solutions built up over the last few years.

There are many active members and you will find that many questions are replied to quickly. When

posting, please try to be as clear as possible, give details your PC's hardware and what has caused the

problem (if you know, obviously).

Before posting anything, please search the Forums first to see if anybody else has had the same problem



in the past. Oh, and Google BSD is a friend too.

Most of the discussions on the forum are done in English, but with PC-BSD covering more and more

countries and languages, we have now also a few non-English sub forums. Apart from these sub forums

you may prefer to use other, unofficial, PC-BSD forums in your native language. This is expanding all

the time, so check availability for your locale regularly!

PC-BSD Germany

PC-BSD Hungary

PC-BSD Poland

PC-BSD Russia

PC-BSD Spain

PC-BSD Ukraine

14.2 The knowledge database

A fair amount of information can be found in the PC-BSD Knowledge Database. You are welcome to

add your hardware in the supported or unsupported list of hardware too! If you think we can add more

entries to this knowledge database, feel free to let us know, and make this database richer!

14.3 IRC Channel

PC-BSD has an IRC channel to connect supporters and users, just like many other open source projects!

To get connected, use the following information:

Server: irc.freenode.net
 Channel: #pcbsd

To find an IRC client on pbidir.com, click here. If unsure which IRC client to use, we suggest Kirc or

X-chat.

14.4 Mailing lists

One of the direct ways the Team stays in touch with the community is by using mailing lists. To stay

up-to-date with announcements and discussions, subscribe to any of the following mailinglists

Announcements (Low traffic)

General

Support

Translations

Beta testing

PBI Developer

Documentation

Developers

Apart from these official mailinglists, there's also a number of non-official mailinglists set up by PC-BSD

users for PC-BSD users. A list of alternative PC-BSD mailinglists can be found here.



14.5 FreeBSD Handbook

We admit that the FreeBSD Handbook may look difficult and technical, but, hey, it won't bite! Why not

have a quick look through to see if your question is answered there or if a solution is suggested for your

problem? PC-BSD has FreeBSD as it's underlying operating system, so everthing in the FreeBSD

handbook applies to PC-BSD as well.

 

15 Additional resources

PC-BSD is part of the BSD family of operating systems based on Unix, and is specifically based on

FreeBSD. Since PC-BSD has a fully functional FreeBSD system included, most adjustments that you do

for FreeBSD also work for PC-BSD. As a result, the majority of FreeBSD material will be useful for you

as an advanced user. Here is a non-exhaustive list of other resources on FreeBSD:

15.1 Forums
The BSD Forums

BSD Nexus

BSD Foren (German)

BSD Forums (Romanian)

BSD Support

Usenet channel - comp.unix.bsd.freebsd.misc

15.2 Search
Google BSD

The OpenDirectory

FreeBSD mail archives search

15.3 Portals and Blogs
The FreeBSD diary

FreeBSD News

O'Reilly's BSD Devcenter

Slashdot BSD

BSD Guru (Polish)

Freebsdlinks

BSD Guides

15.4 Miscellaneous
The FreeBSD Handbook

The FreeBSD FAQ

BSD Hacks (book)

Screaming Electron's tutorials
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16 Supporting PC-BSD

PC-BSD is a community project and hence it can't exist without involvement from its users and

supporters.

16.1 Get involved

In order to make PC-BSD better with each release we appreciate your feedback and help; you can post

ideas, report bugs/problems on the mailinglist, TRAC or the forums, If you like 'playing around' with

operating systems, you can test drive developement snapshots, alpha/beta/rc releases, and if you like

languages, why not translate PC-BSD in your language if it's not available yet? If you like programming,

and especially coding on FreeBSD, we'd love to see you join the PC-BSD Team.

Intermediate and advanced users can help us assisting other users by answering their questions and

trying to solve their problems; on the PC-BSD forums and IRC (13.2).

16.2 Financially

To help the PC-BSD project financially, why not consider making a donation if you're happy with our

product? Alternatively you can buy your PC-BSD installation CD/DVD and cool stuff from FreeBSD

Mall, PC-BSD's sister company. Companies may consider buying professional support from iXsystems.

16.3 Online

We are always interested in more download mirrors. If you have spare web space and bandwidth on

your server, PC-BSD will be greatly helped if you would be willing to donate this to us. More mirrors

means higher download speeds and more (local) servers for users to download from. PC-BSD is also

distributed as torrent and you can help us with seeding, especially the first two weeks after a new

release.

Webmasters and bloggers can put a Spread PC-BSD button on their site and start collecting... Collecting

what?

16.4 Offline

So you love PC-BSD? Why not tell the world about it? Your family, your friends, fellow students and

colleagues? You won't be the only one that likes a free, virus-free, spyware-free and adware-free

operating system. You can burn a couple of CDs and pass them out.


